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About Silhouette 3D™

About this Manual
This manual is intended to provide an overview on how to use the Silhouette 3D™ software. 
While other 3D printers may be compatible, this manual assumes the use of the Silhouette Alta®. 
Instructions on using the Silhouette Alta® may be found in subsequent manuals regarding the 
Silhouette hardware itself, including instructions on setting up the Silhouette Alta® to print or 
loading materials. 

 » The contents of this manual may not be copied in part or in whole without permission.

 » The details and product specifications in this manual are subject to change without notice.

 » The greatest effort has been taken to ensure the clarity and accuracy of the information in 
this manual. Please contact Silhouette or your retailer with any questions you may have.

 » Please note that Silhouette America assumes no responsibility for any liabilities arising out 
of the use of this manual and product.

General Information 
Silhouette 3D™ is design/editing/output software that enables the creation 3D objects and text. 
The software is compatible with the Silhouette Alta® model. Features and printing results cannot 
be guaranteed for compatible 3D printers not offered by Silhouette America. 

Hardware Manual
For more information regarding the print settings and the troubleshooting for the Silhouette 
Alta® and the Silhouette Alta® Plus, please view their respective manuals. You can find them on 
Silhouette101.com.

System Requirements
The following system environment is required to use Silhouette 3D™:

 » Operating system: Windows 7 or Mac 10.8+ 

 » RAM: 4 GB

 » Hard drive: 4 GB of free space 

 » Graphics: Any that supports Open GL 1.2 (Any GPU since 2010)

 » Network: Any network controller (Wi-Fi or Ethernet)

 » Supported 3D Printer: Silhouette Alta®

Software Usage Agreement
Silhouette America Corporation (“Silhouette America”) hereby grants the purchaser and 
authorized user (the “User”) the right to use the software (the “Software”) in accordance with 
the terms and conditions specified. By its purchase and/or use of the Software, the User hereby 
accepts and agrees to abide by the terms and conditions set forth herein.
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Copyrights
All copyrights relating to the Software and accompanying materials, such as manuals, shall be 
retained by the individuals or organizations indicated in the Software or printed materials. 

License
The User may use the Software on one computer at a time.

Copying and Modification
The User may not modify, combine, amend, or otherwise adapt the Software by any means, 
including disassembly and decompiling.

The User may copy the Software for backup purposes.

Third-party Use
The User may not transfer, assign, or otherwise dispose of the rights relating to the Software or its 
use to third parties.

Warranty
Silhouette America provides the Software on an as-is basis. Neither Silhouette America nor the 
supplier guarantees the performance or results that may be achieved using the Software and 
accompanying documentation. Neither Silhouette America nor the supplier gives any explicit or 
implicit guarantees regarding the infringement of a third party’s rights arising from the use of the 
Software or accompanying manuals, their commercial performance, or their suitability for specific 
purposes. Neither Silhouette America nor the supplier assumes any responsibility for incidental, 
secondary, or special damages resulting from the use of the Software or accompanying manuals 
under any circumstances, including cases in which the possibility of that particular damage 
arising is indicated to the User by the retailer. Moreover, neither Silhouette America nor the 
supplier assumes any responsibility for claims from third parties.

Registered Trademarks
The company names and product names described in this manual are registered trademarks of 
their respective owners.

Disclaimer
Some of the software images used in this manual are those that were used when the software 
was under development, and they may be slightly different from those actually displayed. There 
are no differences between the functions and setting layouts shown here and those of the actual 
version.
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Features Overview
The Silhouette 3D™ software includes, but is not limited to, the following software features and 
benefits:

 » Import a variety of file formats

 » Download exclusive digital content

 » Organize and optimize the library collection

 » Print with fonts already installed on your computer

 » Draw different shapes: cone, cube, cylinder, half sphere, pyramid, sphere, torus, hollow 
cylinder, and triangular prism

 » Assemble custom 3D designs with Silhouette Snapkits

 » Resize 3D objects to exact specifications

 » Ungroup and group sets of 3D objects for manipulation

 » Arrange designs by shrinking them, enlarging them, and rotating them

 » Duplicate objects

 » View designs as solid objects or wireframe outlines

 » Snap object to the platform and center it

Software File Formats
The Silhouette 3D™ software uses a proprietary .S3D file format, which consists of vector art for 
line and color/gradient fill type data intended for 3D printing. The Silhouette 3D™ software is also 
able to open .STL* and .OBJ* files in a ready-to-print format.

In addition to files that may be opened or imported, Silhouette 3D™ can also access fonts. Please 
note that Silhouette cannot guarantee the quality or success of fonts not offered by our company 
as not all fonts are designed with 3D printing in mind.

You are also able to create your own 3D objects to slice objects for 3D printing within the 
Silhouette software. There are simple shape-drawing functions built into the software that will 
allow you to do so from within the Silhouette 3D™ program.

*Not all features of these file types may be able to be imported into the Silhouette 3D™ software.

Available Digital Content
The Silhouette 3D™ software comes preloaded with designs. These become available after you 
register your Silhouette Alta®. (Preloaded objects will vary between Silhouette products.)

Additional content is available through the Silhouette Design Store (which can be accessed 
through the Silhouette 3D™ software). The store will allow you to access and purchase additional 
digital content for the software, available both from Silhouette artists as well as independent art-
ists and various companies, thus ensuring a variety in look and feel of available premade content. 
Further information regarding the store and downloading content is included later in this manual.
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Basic Software Overview

Installing Silhouette 3D™
Silhouette 3D™ is a free software available to download from silhouetteamerica.com. Follow the 
prompts to download the software to your computer. Make sure to choose the corresponding 
operating system (PC or Mac) for the computer you are using.

Note for Windows users: upon connecting to the USB cable to the Silhouette Alta® and powering 
the printer on, you may be prompted with a “New Hardware Wizard” to install a driver. You may 
proceed to automatically find and install the driver. The driver is not required to properly operate 
the Silhouette 3D™ software but may be installed to resolve the Windows automatic “Plug and 
Play” feature that prompts you to install a driver for the hardware whenever the Alta is powered 
on. 

Opening the Software
To open the software on a PC, locate the desktop icon and double-click it. If a desktop icon 
was not created during the software installation, go to the Windows Start menu and select 
Silhouette 3D™.

To open the software on a Mac, open the Applications folder and launch Silhouette 3D™.

The Silhouette 3D™ icon will appear as follows: 

Once opened, the software should show an available starting document and workspace as shown 
below:
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Software Sections
The software offers several sectioned areas. Details as to each button’s specific function are 
discussed in later sections. However, so that you may be familiarized with where everything is 
located, a brief overview is provided for each of the sections.

Document management: This section along the top left-hand side is for 
document-management functions, such as opening and saving documents.

Standard editing tools: This section along the top left-hand side 
of the screen is for basic copy/paste/cut and undo/redo actions 
commonly found in many programs.

Object view tools: This section along the top left-hand side of the 
screen is for changing how you view your shapes. You can change 
the object selection, the object view, or the design perspective you 
wish to see.

Page view tools: This section along the top left-hand side of the 
screen is for basic zoom-in or zoom-out functions to view parts 
of the 3D objects from a closer perspective or at a more distant 
range.

Quick-access toolbar/Silhouette 3D™ tools: This section along the top right-hand side of the 
screen appears only when a shape is selected. It provides a range of tools to adjust the position of, 
transform, makes copies of, or center objects.

Tabs: The tabs along the top right-hand side of the screen provide navigation to the Design page, 
the 3D Print page, and the Store.
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Design Area
You will note there are two different sections in your workspace: the white workspace and the 
gray holding area.

The circle workspace is the active document area. 3D objects may be placed or created in this 
area or they may be placed or created in the gray holding area. You may wish to place 3D objects 
off to the side, but you will be able to select these objects individually if you click on the 3D print 
tab to view your print queue. You will note a red border inside this white workspace. The red line 
represents the active printing area. 

Opening Documents
Though opening the software will always provide you with a new document, you may select 
a new workspace to start a new project at any time. To start a new document you may either 
use the New option from the File menu, select the New icon on the toolbar, or use the keyboard 
shortcut Ctrl + N.

To open existing files, you either use the Open option from the File menu, select the Open icon, or 
use the keyboard shortcut Ctrl + O.

You will then be prompted to navigate to the location where your desired file is located. Through 
the Open feature, the Silhouette 3D™ software has the ability to open .S3D, .STL, and .OBJ print 
files.

Document Tabs

Each new document or opened document will provide you with a new document tab in the top 
left-hand corner of your screen.

The tab will be labeled as “Untitled” until you save your file with a name. If you open a file that 
already had a name, the file’s name will be displayed. The white tab will always be the active 
document while other opened inactive documents will be gray. You may click on any inactive tab 
to make it the active workspace and toggle between open documents. Clicking on the “x” in the 
document tab will close any open workspace.
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Page Orientation
Moving the cube around will rotate your workspace on the screen for a different 
perspective. Changing the perspective will not dictate how the design is printed.

Viewing and zooming

As you view your workspace, you may either wish to zoom in to 
get a closer look at parts of a design that may be more difficult to 
work with. Here are the tools from left to right:

 » Zoom in: This tool will zoom into the center of your workspace for a closer view.

 » Zoom out: This tool will zoom out from your view for a more broad perspective.

 » Zoom select: This allows you to zoom in on a specific selection.

 » Pan: This allows you to move your entire workspace around.

 » Fit to page: Clicking the fit to Page icon will immediately fit the full defined workspace to 
the center of your screen.

Perspective and Orthographic Views

The orthographic view: Shows the shape representation how it would be from the given 
angle. The lengths of the sides and so on are more accurately shown here than they are in 
the perspective view.

The perspective view: Shows the point of view that is an approximate representation of the 
shape on the print bed.

Creating and Editing 3D Shapes
The Select tool: The Select tool determines which image is selected as the active image and 
allows you to move arrows around on your screen. This tool is your default tool to click on 
images to show they are selected.

3D shapes: Clicking on this brings up all the 3D shapes that you can create. 

 » Triangular Prism

 » Arrow

 » Cresent

 » Diamond

 » Fish

 » Flower

 » Four-point Star

 » Heart

 » Pentagon

 » Cone

 » Cube

 » Cylinder

 » Half sphere

 » Pyramid

 » Sphere

 » Torus

 » Donut

 » Hollow Cylinder

 » Plus

 » Quatrefoil

 » Star

 » Starburst

 » Teardrop

 » Trapezium

 » Triangle
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Weld and Subtract Shapes
The Weld and Subtract Shapes options let you alter your 3D shapes in a few different ways. Let’s 
show you what these tools can do with two four-point star shapes. (Note: We’ve changed the color 
of one of the shapes so you can see what happens with the different shapes when we use these tools.)

Weld

The Weld tool functions a lot like the Group tool in that it allows you to combine shapes. Howev-
er, unlike the Group tool, you can’t unweld shapes you choose to weld together. (However, you 
can use the Undo function after you weld shapes together in case you change your mind.)

To weld shapes together, make sure they are selected, and then select the Weld option. Now that 
the welded objects are one shape, they are the same color again.

Subtract Last from First

Subtract the last object that was placed from the first object that was placed. In this case, doing 
that left us with four separate pieces.

To do this, make sure your shapes are selected, and then click the Subtract Last from First icon. 
Whatever is highlighted in red will be subtracted.
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Subtract First from Last

Much like how the previous option works, you can choose to subtract the last object placed from 
the first object placed.

To do this, make sure your shapes are selected, and then click the Subtract Last from First icon. 
Whatever is highlighted in red will be subtracted.

Intersect

With the Intersect option, the overlapping parts of the shapes are the only parts that remain in 
the design space. 

To make a shape using the intersect option, make sure your shapes are selected, and then click 
the Intersect icon. 
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Mirror Tool 
The Mirror Tool allows you to create a reversed copy of a shape to help you achieve your desired 
design. It’s a pretty simple tool to use. 

First make sure your shape is placed in your design space. Next, click on the Mirror icon. Then 
select the shape you want to mirror. 

You’ll see a box go around your shape with a selection of arrows. Lastly, select which direction 
you’d like to mirror your shape. 
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Align Tool 
The Align tool can be really useful when you are trying to line up designs. This way, your align-
ments can be perfect, and you don’t have to try to line everything up using your best judgement. 

There are three different align adjustments (align left, align center, and align right) that you can 
make in three different ways: vertically, horizontally, and three-dimensionally. 

To use the Align tool, first select all of the designs you wish to align. Next, click the Alignment 
icon. You’ll see the alignment handles pop up next to the boxes of the shapes you are trying to 
align. 
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Knife Tool
If you want to break up a design into different segments, using the Knife tool is a good option. This 
tool delivers a straight-line cut to separate shapes. 

To use the Knife tool, select the shape (or shapes) you wish to divide. Next click the Knife icon. 
Click to a point just outside of the shape where you would like to start cutting to ensure you’re 
cutting all the way through it. Continue holding your click and drag your mouse to a point just 
outside of where you would like the cut line to end. 

Holding the Alt or Opt key while you cut will keep your line on an axis.

Holding the Shift key will lock your cut line in 15-degree increments. 

Holding the Ctrl or Cmd key and dragging the mouse will reposition the cut line.
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Stretch Tool
Using the Stretch tool, you can extend a design past its original design point. This tool works 
similarly to the Knife tool, and the angle of the split line determines which direction the object will 
stretch.

First you’ll want to create your split point by drawing a line through the design. Click to a point 
just outside of the shape where you would like your split line to be. Continue holding your click 
and drag your mouse to a point just outside of the shape. When you’re done, you’ll see a red line 
through your shape. 

Pick a spot on your shape that you’d like to stretch and put your mouse over it. Click and drag the 
shape away from the split plane, and when you’re finished, release the click. Now your shape is 
stretched. 

Just like with the Knife tool, you can control the position of your split with your Shift key, your Ctrl 
or Cmd key, and your Alt or Opt key. 
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Sculpt Tool
Using the Sculpt tool, you can push and pull a shape into a new unique design. 

To pull the shape, click and drag the shape in your desired direction. To push in hold the Shift key 
while you click in drag in a direction. 

You can adjust the brush size and the strength of the push and pull in the Quick-access Toolbar. 

There is also an option for you to make symmetrical changes to a shape, so whenever you make 
changes to one side of the shape, those same changes will also be reflected on the other side of 
the shape. 
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Preferences
You have the ability to change some of the default settings by adjusting your preferences. Do to 
so, go to Edit at the top of the Silhouette 3D window and select Preferences. You’ll see a box that 
looks like the box below, and there are a few options that you can change.

 

Language: You can select one of six languages: English, Portuguese, Spanish, French, German, or 
Korean.

Unit of measurement: Here you can select your default measurement units. The industry 
standard is for 3D printing is millimeters, but you can change it so that you see measurements in 
inches.

Opening a model larger than the print bed: You can change what the software does when you 
open or import an object larger than the size of the Alta’s print bed. 

Check for updates: Choose how often the software will check for new updates. Your choices are 
daily, weekly, monthly, or never.

You can also check the box if you’d like the software to gather data for performance improvement 
purposes. This just means that if there is a bug or the software shuts down unexpectedly that the 
software will send that data to Silhouette so that bug fixes or improvements can be made for the 
future.
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Creating and Editing Text
3D text: Clicking on this brings up a text box. To create 3D text, type your text, and click “OK.” The 
text will show up in the print area. To change the font, make sure the text is selected and go to the 
upper-left corner. Click the drop-down menu to select a new font. You can select any font 
available on your computer.

Change the color of the shapes or text in Silhouette 3D™ by making sure the shape 
or text is selected and then clicking on the square below the New File option on the 
Document toolbar.

Note: Changing the color of the shape in the software will not affect the color of the 3D print. The 
only way to change the color of a 3D print is the change the color of the filament.

Silhouette 3D™ has the ability to utilize any font that is installed on your computer. You do not 
need to install these fonts into the program. Silhouette 3D™ will simply access all installed font 
files and display them for you as you go to create your desired text.

To use your fonts, click on the Text tool and type your desired text. Click “OK.” Your 3D text will 
then appear in your print area.

Manipulating text

To change the font, make sure the text is selected. Go to the upper left-hand corner and click on 
the drop-down menu to select a new font.

Font characteristics

Some fonts are programmed to enable the use of certain style characteristics that allow you to 
bold or italicize text or letters.

You can move and adjust the text the same way you move and adjust the shapes. To change the 
text, double-click the box and enter the new text. To change the font, make sure the text box is se-
lected and go to the top of the Silhouette 3D™ page. On the left side under the Document Tools, 
you will see a drop-down menu where you can select your font. To change the text, double-click 
on the text and type in the new text.

While you can’t type in a text size you wish to apply, you can use the white squares to make the 
text bigger or smaller. 
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Manipulating Shapes
There are many tools in Silhouette 3D™ allowing for basic and advanced manipulation of objects 
and text. The following section provides an overview for all of these included tools and how they 
may be used.

Selecting Shapes

Objects may of course be selected by clicking on them. Multiple objects may be selected by 
holding down the Shift key on your computer keyboard and clicking on another object. You may 
repeat this action to select as many objects as desired. Holding down the Shift key and clicking on 
an object that is already selected will deselect that object.

Multiple objects may also be selected by clicking above an object and dragging your mouse to 
select all objects to be selected at the same time. As you hold your mouse button down and drag 
your mouse, you will see a solid line creating a selection box that shows what you are selecting. 
Upon letting go of your mouse, all enclosed objects in this box will be selected together in the 
same bounding box.

If you wish to select all available objects on the screen together, you may click on the 
Select All button located in the quick-access toolbar.

If you wish to deselect all currently selected objects, you may click on the Deselect All 
button located on the quick-access toolbar.

Cut, Copy, and Paste Tools

These tools perform the basic expected actions of copying selected objects, pasting them, or 
cutting them from view. Objects copied or cut will reside in your computer’s memory on a virtual 
clipboard. You may have only one object on this clipboard at a time. This means if you copy one 
object and then copy another, only the most recent object will be waiting on the clipboard to be 
pasted. These actions may be accessed from the top toolbar, in the Edit menu, or by right-clicking 
on an object as well as by using standard shortcut keys for these actions (see page 25 in this 
manual).

Pasting copied object will place the copy directly next to your original object so that you may 
easily see and find your copy. 

Duplicate

The Duplicate option performs the same action as copying and pasting the selected object to the 
side but does so without the need of utilizing your clipboard and is a one-click operation. This 
toolbar button is located at the top of the software screen and can alternately be located in the 
Edit menu or by right-clicking on a selected object.

Delete

Selected images may be deleted from your workspace by clicking on the Delete button located 
at the top of the software screen, by accessing the Edit menu and selecting Delete, right-clicking 
a selected image and choosing the Delete option, or by simply pressing the Delete key on your 
computer keyboard.
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Undo/Redo

Any action taken, including simply moving an object, may be undone. To back up to the previous 
action taken, click the Undo button. There are an unlimited number of actions you may go back to 
with the Undo button, including going back to when you first opened your new workspace.

Similarly, you may click the Redo button to repeat any actions you may have undone. You may 
continue to use this button until you return to the last action taken.

Grouping and Ungrouping
These two actions are commonly used and are invaluable tools for helping to manipulate and 
adjust objects. To understand these concepts, we must first understand what grouped and 
ungrouped objects are.

 » Grouped objects consist of multiple shapes that make up an entire design.

 » Ungrouped objects usually consist of a single shape. 

 » The only exception to this in Silhouette 3D™ is with text. When you create text, the letters 
are automatically grouped together for you. 

Grouping

 » Any two sets of designs can be grouped together so they are fixed in their relative posi-
tions, even if moved, by using the Group option.

 » To use the Group option, select two or more images at the same time and click on the 
Group icon located in the quick-access toolbar. This can alternately be located in the Object 
menu or by right-clicking on the multiple selected images and selecting Group.

Ungrouping

 » Any image that contains more than one design set can be ungrouped so that parts of 
the design may be treated independently to allow for removal, rotation, resizing, or other 
manipulations. This way, the user doesn’t have to manipulate the design as a whole.

 » Once ungrouped, the design will be displayed showing individual selection boxes around 
each new ungrouped image part that can now be manipulated. To access the individual 
ungrouped parts, you may unselect the entire design. 
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Moving Shapes
Objects may obviously be moved by selecting them and then dragging them around the screen 
with your mouse to any desired location. Selected objects may also be moved by using the arrow 
keys on your computer keyboard.

Rotating Shapes
Objects may be rotated to any desired angle, and there are several ways to rotate your design. 
You can use the arrows on the toolbar to rotate the placement of the object in 90° increments on 
the mat. When the object is selected, you can also use the rounded arrows to rotate the design.

Sizing Shapes
Objects may be sized to any desired measurement. It is important to note, however, that while 
you may customize designs to any desired size, the quality of prints made may vary. Reducing the 
size of a design with intricate parts is an example of where the print quality could suffer.

There are control points on the selection box for resizing designs manually. To resize manually, 
simply click on any of these boxes and drag your mouse in the desired direction to make your 
shape larger or smaller. The corner control points will stretch your object in the direction your 
mouse is dragged. Hold down the Shift key when you click and drag a white square if you would 
like to change one part of the shape instead of having the shape change in size overall.  

Aligning Shapes
If at any time you move a shape around on the print bed, you can use the alignment options to 
make the shape level with the platform or center the shape in the middle of the platform. Note: 
When you go to the 3D print tab, the software automatically centers the shape and makes it level to the 
print bed. 

You can bring your design level with the print bed by click on this icon.

You can center objects in the middle of the print bed by clicking the target icon when a 
design is selected.
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Using the Toolbar to Adjust Objects
When you have an object in your design space, you have the ability to check or change its 
dimension, rotation, and scale. Make sure the object is selected, and then go to the toolbar above 
the design space. You’ll see a drop-down menu where you can select “Dimensions,” “Rotation,” or 
“Scale.” 

Dimensions: You can change the size of an object by changing the width, height, and depth of an 
object.

Rotation: You can change the x, y, or z axes to rotate your shape in a specific position. The x-axis 
is the horizontal axis, the y-axis is the vertical axis, and the z-axis is the axis is the depth axis.

Scale: You can change the scale of an object by adjusting the width, height, or depth. 

Aspect Ratio Lock: With the dimension and scale options, you have the ability to lock in the ratio 
aspects by clicking on the lock icon. This means that when you make a change, the software will 
change the other measurements to keep the object proportionate. Note: The aspect ratio lock and 
unlock only works for the Dimension and Scale options.
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Creating Lithophanes
A lithophanes is a 3D printed model made from a 2D image. The image will appear clearly when 
it is backlit. 

To create a lithophane, first open an image in Silhouette 3D™. When selecting an image to use, 
it’s best to select one with high contrast colors, but you also want to select one that has some 
texture to it to create a more interesting design. 

You can do this by clicking the Open folder icon and navigating to the photo you wish to use. 
When you click Open, a window of import options will come up, and there are six different 
lithophane choices: Flat lithophane, elevation map, lithophane tube, lithophane tube half, 
lithophane tube third, and lithophane tube quarter.

When you are ready to print, go to the 3D Print tab and make sure to select the Lithophane print 
profile. This way, your machine will print your lithophane design properly. For best results, make 
sure to use white filament when printing a lithophane.

Flat Lithophane Elevation Map Lithophane Tube

Lithophane Tube Half Lithophane Tube Third Lithophane Tube Quarter

Silhouette Pro Tip: When the lithophane is created, you may wish to 
change the color of the shape to white. The white color makes the design 
easier to see in Silhouette 3D™. 
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Library and Design Store

Silhouette 3D™ offers a library feature to keep and categorize all of your downloaded and 
user-created designs for easy reference. There is a tab you can click to access the Silhouette 
Design Store so that you can view and download new content.

The library and store views may be found in the right-hand tabs of the software screen. You can 
see which panel of Design, 3D Print, and Store is currently selected because it will be highlighted. 

Library
The Library is where all of your preloaded and purchased content is contained and may be 
categorized, sorted, and accessed.

 » You are able to view your designs as icons by clicking on the Icon View option.

 » You may alternately view your library designs in a list view to see more detail by clicking on 
the List View option.

 » In List View mode, you may sort your designs by name or date added. 

Accessing Library Content
 » To access library designs, you may double-click your object to open it onto your workspace.

 » You may also drag designs from your library onto your workspace (only if your workspace 
is being displayed). 

Categorizing Designs and Managing Your Library
 » As your library continues to grow with additional content, you may find it convenient to 

customize your library with new folders and sort designs according to your liking.

 » You may add new custom folders by right-clicking and selecting “New Folder.”
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 » As new folders are created, you may immediately name your folder a desired name. 
Once your new folder has been created, you may drag and drop objects into the folder. 
Right-clicking on a folder will allow you to create a new subfolder for that selected folder, 
delete the folder (along with all contained content), or rename the folder.

 » In addition to customizing folders, you may also adjust any of your objects within the 
library. Right-clicking on an object will allow you to delete the object, rename the object, 
sort the objects in the current folder, or show/hide the object properties. 

 » As objects or folders are deleted, they will be moved into the library’s recycle bin. You 
may still restore any of these objects or folders by dragging them back into your library. 
However, once you have deleted any content from your recycle bin, this content will be 
permanently deleted from your computer.

 » Use the View as Icons button and View as List button near the top right-hand side of the 
window to change the view of your designs in the right panel.

 

Silhouette Design Store
The Silhouette Design Store provides additional downloadable content from not only Silhouette 
but also a variety of independent artists and contributing companies. The Silhouette Design 
Store can be accessed from within the Silhouette 3D™ software as long as you have an internet 
connection.

The store is accessible at any time—24 hours a day, 7 days a week.

While objects may be purchased individually to customize your library experience, subscription 
options are also available for a monthly fee. Further information on subscriptions may be found at 
the Silhouette Design Store.

All images are provided with the following benefits:

 » You may download images using any major credit card, download cards, or subscription 
credits.

 » Indefinite usage (you do not have to be connected to the Internet to access designs once 
purchased)

 » Recoverable (in case of computer crash or replacement)

 » Resizable and customizable to your specifications (using Silhouette 3D™ tools discussed in 
previous sections)

Logging in to the Design Store
 » Upon accessing the Silhouette Design Store by clicking on the Store tab, you will be 

brought to the store’s homepage.

 » You may sign in, or sign up for an account if you do not already have one created, by 
clicking on the link in the upper right-hand corner. 

 » To create an account, you will need to provide your name, your email address (which will 
be your login name), and any desired password.
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My Account Options
Once logged into your account, you will find a link in the upper right-hand corner called My 
Account that will provide you with tools to manage your account. You will have the following 
options:

 » Change My Account information: Alter your email and password.

 » My download history: View a copy of all orders placed. When viewing specific orders, you 
may also opt to recover a specific order if there was any break in connection during the 
download process.

 » Recover All Downloaded Designs: Recover any and all previously downloaded content if 
you are seeking to load the software onto a new computer. This is helpful if your computer 
crashes or you replace your computer. 

 » Add a download card to my balance: Enter any download card codes to apply the available 
balance to your account.

 » Manage My Credit Cards: Manage any credit card information on file used to pay for 
subscriptions or individual purchases.

Shopping Designs
You are free to browse all available Silhouette content without any obligation to purchase. You will 
find a navigation aid on the left-hand side of your shopping window. As categories are selected or 
as you search for designs, you will also find related suggestions listed.

To search for specific designs, you may enter any names or terms in the upper right-hand corner.

As you browse through the different themes and releases or make specific searches, once you 
find an image you would like to download, you may add it to your cart by clicking on the Add to 
Cart option.

Below the design is a listing of similar or related designs you may be interested in as well.

Note that images that have already been purchased cannot be added to your cart and will show 
that you already own them.
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Downloading Shapes
You may continue to browse and add additional images until you are ready to check out. Once 
you are ready, you may either click on the cart in your mini cart preview or click on the icon in the 
upper right-hand corner of the shopping window.

When you are ready to download your selected designs, simply click the Checkout button. If you 
have a balance on your account from a download card or subscription credit, the total charges will 
be taken from your balance automatically. If you do not have a balance or your account balance 
does not cover the total of the designs you are seeking to purchase, you will be prompted to either 
provide credit card information or add a download card code to your account.

Once ready, you will be prompted for your password to authorize your purchase. Upon entering 
your password to confirm the purchase, the library will appear in a panel above the store, and you 
will be able to view your designs as they are downloaded into your library.

You may then continue to navigate through the Design Store or close it as desired. Once your 
designs are all downloaded, you may then drag them from the recent download section and sort 
them as desired into any of your library folders. Downloaded designs will remain in the Recent 
Downloads folder until sorted.

You will note that while all purchased designs are stored in your library, purchased fonts will also 
be referenced in the library in a special “Fonts” folder. You may then either access these fonts 
purchased through the Design Store by double-clicking on these from the library, which will bring 
you to your workspace with a text cursor ready to place to type or type the text and change the 
font as previously discussed in the “Creating and Editing Text” section.
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Turning 2D Designs into 3D Objects
The Silhouette 3D™ software is unique in that it can turn some 2D designs into select 3D objects. 
Some 2D designs will work better than others, so you may have to play around and do some 3D 
test prints to see which designs will work the best.

There are six different 3D import options you can choose from: extrusion, cookie cutter, jewelry 
box, stencil box, stencil, and wax pendant. With the example above, we picked the earrings design 
and chose the extrusion option, which extended the thickness and made the design 3D. 

Using Snapkits
Build custom objects with predesigned pieces called Snapkits. Start by going to the Snapkit folder 
in your library and choosing a piece. Then select another piece. When you move a piece around, 
you’ll see that there will be two red circles in a few spots. This shows you where you can snap the 
pieces into place. Text boxes can also be used as Snapkit pieces.

Diamond Earrings by Lori Whitlock—Design ID #268357
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Importing Designs
One great feature of the Silhouette 3D™ software is that you can import designs from any 
third-party sources as long as the designs are in a compatible file format (i.e. .STL and .OBJ). 
There are many third-party websites online that offer 3D designs for you to use. Just make sure 
you comply with the appropriate product licenses that are listed when you download the file. 

When larger designs created outside of Silhouette 3D™ are imported into the software, a pop-up 
window will come up and ask you if you’d like to decrease the size of the object to fit the print 
bed. If you click “Yes,” the software will autoscale the design to a smaller size. If you click “No,” 
the object will be imported at its original size. You still have a chance to decrease the size of the 
object manually.  

Importing Multiple Designs

Many designs that are imported can come with multiple pieces you can print and glue together. 
Take this drum set design for example. There are many pieces that make up this design, and to 
make sure they all fit together properly, you want to make sure you scale them all together. 
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To import multiple files, follow these steps:

1. Open Silhouette 3D™ and click on the folder icon in the upper left-hand corner or click File and 

select “Open.”

2. Locate the files you wish to open.  

Note: Often when you download designs from a third-party source, the designs come in a 

zipped folder. In order to successfully import the designs into Silhouette 3D™, you must first 

extract the files before you attempt to open them in the Silhouette software.

3. Click on the files you wish to open. To select multiple files, hold down the Control or Command 

key and click on the files.

4. Decide whether you want to have the software scale the design automatically. The software will 

automatically detect if the design will be too big to print.

5. Proceed to alter or change the designs or print settings as needed. 

Adding multiple designs at once is a great way to make sure you are scaling your designs, 
whether manually or automatically, the same amount. Plus, all of your designs will be on the same 
page, and you won’t have to worry about working with multiple documents.
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Silhouette Library
Silhouette Library works hand in hand with the Silhouette software to keep all of your designs 
synced on multiple devices. You can sync up to five devices with your cloud account. If you aren’t 
using multiple devices, Silhouette Library is useful in backing up your designs and preventing the 
need for recoveries.

In Silhouette Library, there is unlimited storage available for Silhouette Design Store downloads. 
There is 1 GB available for custom content. Club Silhouette members receive 5 GB of storage for 
custom content.

The panel on the right-hand side will immediately prompt you to sign in to your Silhouette 
account, where you can access your stored designs. Sort and organize your designs any way 
you would like by adding folders and subfolders. You can also sync your account to add any new 
designs you may have purchased recently as well as check out how much cloud storage you still 
have available.

If at any time you want to minimize the library panel, click the tab with the two arrows pointing 
to the right. The panel will then minimize. To open the panel again, click the same tab with the 
arrows now pointing to the left.
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Recovering Shapes
Silhouette America maintains a database of all Silhouette users and their download histories. 
In the event of a computer crash or replacement, after reloading the software onto your new 
computer, you may log in to your Silhouette user account with your email address and password. 
Once logged into your account, you may go to the My Account options to select “Recover All 
Downloaded Designs.”

If you have multiple computers (such as a desktop and a laptop) and are simply seeking to 
recover your most recently purchased images to a secondary computer, rather than using the 
Recover All option, you may visit My Download History in your account options to access a list of 
your previous purchases. In this section, you may click on any previous order number and recover 
your order. You may only perform individual order recoveries to a limited number of computers 
that you expressly own.

Using the recovery features will not, of course, recover any user-created designs you may have 
created (unless you specifically saved those designs to the cloud account). The storage is limited 
for non-Silhouette content, however (1 GB for standard users or 5 GB for Silhouette Club mem-
bers.) You may back-up your user-created designs by simply locating where you have saved your 
user-created files and saving them onto a disc or other storage device.

Silhouette America does regulate the number of unique computers you log in to and reserves the 
right to suspend or remove accounts of registered Silhouette users whose account activity may be 
suspicious or indicative of public file sharing.

Saving Shapes
After you have created an image or document layout, you will have a variety of options to save 
your images.

Save

 » The Save option is the basic saving function to allow you to create a .S3D file and save to 
any location on your computer. These files may be backed up on any removable or external 
memory device.

Save As

 » This option found in the File menu will allow you to name your design as it is saved. It is 
saved to any specified location on your computer and can be backed up to a removable or 
external memory drive as desired.

Save Selection

 » This option found in the File menu will save a .S3D file of only the actively selected designs 
from your document. It is saved to any specified location on your computer and can be 
backed up to a removable or external memory device as desired.

Save to Library

 » This option found in the File menu will save your file into the Library in Silhouette 3D™. 
Upon saving images to your Library, they will be added to a section labeled User Designs 
in the Library. You can’t navigate to these images on your computer to manually back 
them up, so it is highly recommended to save a copy of any designs using the regular Save 
option. 
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3D Print
After you are done making any adjustments to your design, save any changes, and click 3D Print 
tab. Silhouette 3D™ automatically constructs a 3D model according to the default settings, and 
you’ll be able to see how the printer will construct and print your shape. Click the Play button at 
the bottom of the page to see the different layers the printer will print.

In the upper right-hand corner, there is a box that shows you the status of the Silhouette Alta® as 
well as an estimate of the total printing time and the amount of filament needed. 

Print Settings
Silhouette 3D™ already has seven selected print settings for you. What setting you choose 
depends on what kind of print you are making. If you are making something that you are just 
testing and don’t need it to look particularly great or hold up for a long time, you’ll probably want 
to select the draft print settings. If you are making something that needs to look nicer, select the 
high-quality settings. 
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Multi-Alta Support
If you are using multiple Alta machines to print, you have the ability to print using all machines 
simultaneously. Simply make sure each machine is connected to your computer via USB cables. 
When all the Altas are connected to your computer and turned on, you can select them from the 
panel on the right-hand side and make adjustments as needed.

Advanced Print Settings
You have the ability to create your own print profiles for your own specific projects, and you are 
able to change any settings that are preset in the software. The necessary settings will depend on 
what you are making and what you want to use it for. There are many additional resources online 
to help you decide what adjustments to make. When you are done making changes to a profile, 
click “Save.”

To create a new profile, click on the gear icon next to the drop-down list of print-quality profiles. 
Choose an existing profile to base your new profile off of and make whatever changes you need. 
When you’re done making changes, click “Save As,” and then you can name your new profile.

When you open the Advanced Settings window, you’ll see a bunch of settings and four tabs: 
Layers and Infill, Supports and Adhesion, Speed and Extrusion, and Filament and Printer Options. 
If you need help learning about what each setting is and what adjusting it will do to your 3D print, 
you can read the descriptions located to the right of the settings. 
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Slicing Your Design
After you have adjusted your print settings, Silhouette 3D™ will automatically slice your design. 
This just means that the software will break down your shape into layers it needs to print. Don’t 
be alarmed if you don’t see the exact shape that you originally had on your design page because 
when slice your design, it adds in the brim and bottom layers as well as rafts and supports, if you 
added them. 

If you have multiple designs on the Design page that aren’t grouped together, Silhouette 3D™ will 
separate each object and put it in its own print job. A print job won’t print unless it is selected. If 
you wish to print multiple objects at the same time, you must group them together when you are 
in the Design tab. 
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Calibrating Your Machine
Your machine already comes calibrated, so when you set it up, it should be ready to go. But should 
you run into an issue with your machine’s calibration, you must start the calibration process from 
Silhouette 3D™. 

To do so, you can follow the instructions listed below or view the Calibrating Your Silhouette Alta 
video on YouTube.

1. To check the calibration, go to the 3D Print tab in Silhouette 3D™. 

2. Go to the box on the upper right-hand side and make sure your machine is selected. 

3. Click on the circle icon with three dots in the left-hand corner of the box. 

4. The software will tell you to take a piece of copy paper, cut it in half length-wise, and place 
it on the platform that already has platform tape on it. The paper is what you will use to 
test the optimal position of the print head. Don’t use a folded up piece of paper. If the piece 
of paper you are using is too thick, the calibration will be off. When you’ve got a piece of 
paper ready, click Start in Silhouette 3D™.

5. Hold the paper on one end. The machine will move the print head to three different points: 
the front-left position, the front-right position, and the back position. 

6. When the print head goes to each position, attempt to slide the paper under the print head 
to see whether you can move it. The paper shouldn’t be too easy to move. You should feel 
some resistance when you try to move it, but the paper shouldn’t be so hard to move that 
you bend or damage it.

7. In the software, indicate whether moving the paper at each point is easy, normal, or hard 
and click Next. The software will then tell you which section needs to be adjusted. 

8. If you indicated a point was too easy, you need to tighten the screw. 

9. If you indicated a point was too hard, you need to loosen the screw. 

10.  Once you’ve adjusted the screw, click Test Again in the software. 

11. The Alta will lower the print head and have you test the point again with your piece of copy 
paper. 

12. When all of the points are normal, you’ve completed the calibration process.
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Inserting Filament
To load the filament in your Alta 3D printer, start by opening Silhouette 3D™, and powering on 
your Alta. In the software, click on the 3D Print tab. In the upper right-hand corner, ensure that 
your machine has been selected. With the Alta selected, click on the Filament button. Next, click 
on Load Filament and go through the following steps to load your filament properly.

Place your filament spool on top of your machine and put the roll of filament on the spool. When 
using filament that comes in either a loose roll or a reel, it is important to make sure that you keep 
a hold of the leading end because the filament can become tangled. 

On top of the machine, there is an eye and the filament clip. Feed the filament through the eye 
and the filament tube. To prevent the filament from becoming tangled and jamming the machine, 
push the filament tube back through the eye. Then insert the filament tube through the filament 
loading lever. Press the tab on the loading lever to open the hole where you can insert the filament 
and the filament tube. The filament tube doesn’t need to be pushed in very far; it just needs to go 
in far enough to the point where the loading lever grabs it when the lever is released. The filament 
should be pushed through the filament tube about an inch or so, until you see the filament in the 
filament hose near the top of the machine. 

Click Next in Silhouette 3D™, and then click Load. The machine will feed the filament through the 
inner print tube and heat up the print head. The print head will then move down and print small 
amount of filament once the filament is warmed up.

Printing Your Object
When you’ve finished loading your filament and adjusting your print settings, click Print. Your 
machine will beginning printing your object. After the Alta is finished, make sure to let the object 
cool before you attempt to remove it. 
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Action PC Mac

New Document Ctrl + N Cmd + N

Open Document Ctrl + O Cmd + O

Save Document Ctrl + S Cmd + S

Copy Ctrl + C Cmd + C

Paste Ctrl + V Cmd + V

Cut Ctrl + X Cm + X

Undo Ctrl + Z Cmd + Z

Redo Ctrl + Shift + Z Cmd + Shift + Z

Fit View To Window Ctrl + 1 Cmd + 1

Save As Ctrl + Shift + S Cmd + Shift + S

Save To Library (Must be signed 
in to your Silhouette account)

Ctrl + Alt + R Cmd + Alt + R

Close Document Ctrl + W Cmd + W

Quit S3D Ctrl + Q Cmd + Q

Duplicate Object Ctrl + D Cmd + D

Select All Ctrl + A Cmd + A

Deselect All Ctrl + Shift + A Cmd + Shift + A

Move Left Left Arrow Key Left Arrow Key

Move Right Right Arrow Key Right Arrow Key

Move Up Up Arrow Key Up Arrow Key

Move Down Down Arrow Key Down Arrow Key

Move Up (Z Axis) Shift + Up Arrow Key Shift + Up Arrow Key

Move Down (Z Axis) Shift + Down Arrow Key Shift + Down Arrow Key

3D Print Ctrl + L Cmd + L

Group Ctrl + G Cmd + G

Ungroup Ctrl + Shift + G Cmd + Shift + G

Pan and Move Hold Middle Mouse Button + 
Move mouse

Hold Middle Mouse Button + 
Move mouse

Show Library Ctrl + Alt + S Ctrl + Alt + S

Show Store Ctrl + Alt +L Ctrl + Alt +L

Keyboard Shortcuts


